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Poll: About you




Introduction

The Map and Data Library

e Access data collections
e Workshops and training https://mdl.library.utoronto.ca/

md| @ library.utoronto.ca
e One-on-one consults 416-978-5589

e Appointment-only until summer 2025 11am - 5pm, Monday - Friday
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Map and Data Library

Tutorials and Workshops

https://mdl.library.utoronto.ca/support/tutorials
https://mdl.library.utoronto.ca/support/workshops-and-training

SITY OF TORONTO MAP AND DATA LIBRARY

LIBRARIES

COLLECTIONS = TECHNOLOGY ~ SUPPORT = MY ACCOUNT T Q SEARCH MDL

MDL Tutorials

Displaying 1 - 14 of 14 Tutorial Results

Search Tutorials

An Introduction to Mapping and Spatial Analysis with QGIS
Learn the basics of GIS with open source software, QGIS (https.//qgi £). This tutorial’'workshop is made up of three
modules

* Module 1. Getting started

* Module 2. Making a map using layouts

* Module 3. Manipulating geospatial datasets

Download the datasets used for this workshop at this
location: http

Note that while the examples shown in this tutorial were captured using the windows version of QGIS, all modules and

Search Tutorials Reset operations can be completed using the linux or mac OS version of QGIS

Technique: Mapping, Spatial Analysis | Tools: QGIS
Date Created: 2022-11-01

ArcGIS Pro: Information, Tutorials, and Workshops

is a desktop GIS software developed by Esri and IS intended to replace ArcMap




statistical software

LibrarySearch MDLSearch

Search Map and Data Library website

idor Q|

Scholars GeoPorta | Geospatial data

A . a3 5
Q Numeric data

Remote sSenung |

MDL Data Collection on Boreals | Microdata | Statistics

Q Maps and atlases

d Mag Fre irgurarke plans

Rare maps | Topographik maps

Alr photos

Census of Canada

Search for data

TECHNOLOGY =

MDL collection search results

lidar

Geospatial data

Toronto Lidar 2015
Toronto Lidar 2015 The Lidar data was collected between Apnil 20, 2014

Toronto Lidar Data - 2008
.. Toronto Lidar Data - 2008 Please note that a license .. / External HD [4) /
FTP {(enquire) Format LIDAR Restrictions FACULTY STAFF STUDENTS

York Lidar Data 2019
York Lidar Data 2019 Creator Airborne Imaging ... to use Citation Mediu
m MAdata\private\toronto\lidar\Airbornelmaging2019\York2019webdata

Map and Data Library

Q SEARCH MDL

or find "lidar” in LibrarySearch

T I E S I R

Statistics

Ozone data for the world
oronesondes, Umkehr N and retrieved values, lidar and surface ozone

Distributor Environment




Scholars Geoportal
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What is GIS?




How is GIS used?
e Choosing the right location
 Finding the best route
e Keeping track of things
e Planning for the future

e Responding to emergencies
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Map Insert Analysis ' Edit Imagery Share Help Feature Layer Labeling Data
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Vector Data: Attribute Table

- Road X
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GEO ID
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7641209
7323458
20103021
913835
9950042
10618658
9949991
913692
9950065

7323524

o 4 »

Selection: ¥

LF NAME

Island Rd

Ansell Ave

Lake Shore Blvd W
Fortieth St
Brockhouse Rd
Brockhouse Rd

F G Gardiner Xy E
Lloyd George Ave
I'he Queensway
Alcan Ave

Atomic Ave

Lloyd George Ave

Fvans Ave

0 of 50,563 selected

Select By Attributes

ADDRESS L

25-25

3795-3815

30-42
1581-1633
29-35
20-54
44-52

57-469

* Switch

ADDRESS R

89-107

29-35
1580-1640

22-34

49-55

460-460

FCODE DESC*

Other

Local

Major Arterial
Local

Local

Local
Expressway
Local

Major Artenal
Local
Collector
Local

Maior Arterial

JURIS CODE *
PRIVATE

CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO
CITY OF TORONTO

CITY OF TORONTO

Shape Length *
232.814506
53.934218
12447718
128.81571
153.729822
188.058/742
507.054913
161.392988
636.627116
139.644637
688.276411
121.256258

147922736

Shape *
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline
Polyline

Polvline




Vector Data: Symbology
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Vector Data: Symbology
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ArcGIS Pro

e Create 2D and 3D maps, perform spatial analysis,
integrate/manage data, and process imagery.

e Connect to web portals and share content to ArcGIS
Online.

e Tools for analysis and map creation.
e Customizable functionality with Python or R.

e Includes Al and machine learning tools for spatial
analysis.

e Windows only

Arc Pro




ArcGIS Pro

Arcl Pro

e ArcGIS Pro completely
replaces ArcMap (also
known as ArcGIS Desktop)




Other popular GIS applications

QGIS - Open source, cross-
platform desktop app

% ArcGIS Online - web-based
ARGIE Ol ArcGIS mapping platform




Accessing Pro

Where to find computers with GIS

software
e Map & Data Library

e Robarts Library (fourth floor lab and first floor)
e Gerstein Science Information Centre

e Engineering and Computer Science Library

e Mathematics Library

e John W. Graham Library (Trinity College)

e John Kelly Library (St Michael's College)

e Pratt Library (Victoria University)

e Emmanuel Library (Victoria University)
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Accessing Pro

Install ArcGIS Pro

e Open a web browser

e Navigate to arcgis.com (or utoronto.maps.arcgis.com)

e

ArcGIS Online

a using interactive maps. Work with smart, data-driven styles and intuitive
ights with the world or specific groups
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Accessing Pro

Install ArcGIS Pro

e Your ArcGIS Organization’s URL: utoronto.maps.arcgis.com
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Install ArcGIS Pro

Sign in to University of Toronto ¢9esri

ArcGIS login

Not a member of this organization?




Install ArcGIS Pro

s Cole White
. 1 s ~ . a i ) e
Home Gallery Map Scene Notebook Groups Content Organization Q j? e R —

Training

Community and
Cole White Forums

whiteco7_utoronto ArcGIS Blog

Help

Sign Out




Install ArcGIS Pro

_ . . . - sos Cole White
Home Gallery Map Scene Notebook Groups Content Organization Q (“. ais s
. whiteco/_utoronto

My settings

Licenses

Licensed products ® Add-on license

License

> @ ArcGIS Pro extensions

. D: Essential Apps
> o" Field Apps
> @.’ Office Apps

g ArcGIS CityEngine

@ ArcGIS Data Pipelines

@ ArcGIS Drone2Map

@ ArcGIS Field Maps Designer

@) ArcGls Fiight
@ ArcGIS GeoBIM

@ ArcGIS Image Analysis

@ ArcGIS Image Hosting




Install ArcGIS Pro

> 0. Essential Apps

> o.' Field Apps

> @.‘ Office Apps

g ArcGIS CityEngine
@ ArcGIS Data Pipelines

@. ArcGIS Drone2Map

@ ArcGIS Field Maps Designer
B2 ArGIs Flight

@ ArcGIS GeoBIM

@ ArcGIS Image Analysis

@f ArcGIS Image Hosting

@ ArcGIS Image Hosting

@ ArcGIS Notebooks

@ ArcGIS Pro

@ ArcGIS QuickCapture Web Designer

Download ArcGIS Pro

@ ArCGIS Rilivtinié Advancsd

@ ArcGIS Web Editor

Trust Center Contact Esri Report Abuse Contact Us




Install ArcGIS Pro

e You may also need to install

Microsoft .NET Desktop
Runtime from

https://dotnet.microsoft.com

/en-us/download/dotnet/8.0

QO B8 = hy tnet.microsoft.com

&' .NET Release Candidate (RC) Want to try out the latest RC release? .NET 9.0.0-rc.1 is available.

Download .NET 8.0

@ Notwhat you're looking for? Visit the downloads page for more options.

N\ 8.0.8 SN

Latest release date September 24, 2024

Build apps - SDK ®
SDK 8.0.402

[OS Installers Binaries

Included runtimes
.NET Runtime 8.0.8
ASP.NET Core Runtime 8.0.8
.NET Desktop Runtime 8.0.8

Language support
C#12.0

F# 8.0

Visual Basic 16.9

SDK 8.0.401

[OS ' Installers Binaries

Linux ‘ tructions | Arm32 | A

mac0Ss

Windows lr 64

Run apps - Runtime ©

ASP.NET Core Runtime 8.0.8

The ASP.NET Core Runtime enables you to run existing web/server applications. On
Windows, we recommend installing the Hosting Bundle, which includes the .NET
Runtime and lIS support.

1IS runtime support (ASP.NET Core Module v2)
18.0.24201.8

0s Installers ‘ Binaries

.NET Desktop Runtime 8.0.8

The .NET Desktop Runtime enables you to run existing Windows desktop applications. This
release includes the .NET Runtime; you don’t need to install it separately.

‘ Installers Binaries

Windows

NET Runtime 8.0.8

The .NET Runtime contains just the components needed to run a console app. Typically,
you'd also install either the ASP.NET Core Runtime or .NET Desktop Runtime.




Projects in ArcGIS Pro

S

Databases

Project
/ file (.aprx)

]

Folders

(PR

m /A

Toolboxes

Styles

000 C———O

A~N°

Layouts
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Exploring Data

Download and unzip the sample data:

https://uoft.me/IlntroToPro




e | aunch ArcGIS Pro

e Choose Open Another Project

(P ArcGIS Pro

New Project

ﬁ Home
ED Learning L=

Resources Catalog

@ Settings

Recent Projects

Global Scene

Local Scene

Start without a template

@@ Open another project

= (=)

@ Cole - University of Toronto

Learning Resources

Recent Templates (@ Start with another temp...

41



e Navigate to ArcGIS Pro Introduction.aprx

e Click OK

| v ProWorkshopGraphics Vv O || L= | Search
Organize v New ltem Vv
4 @A Portal - Name Type
My Content B .backups Folder
My Favorites I data Folder
‘g% My Groups B GpMessages Folder
My Organization — ImportLog Folder
ArcGIS Online =P Folcler
Living Atlas . ArcGIS Pro Introduction.aprx ArcGIS Pro Project
4 [ Computer | .
P o Quick access
I <&@ This PC
B Cole White

Name | ArcGlIS Pro Introduction.aprx Projects (APRX, PPKX)
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The Pro User Interface
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The Pro User Interface
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The Pro User Interface
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e From the View tab, click the Contents button
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e From the View tab, click the Catalog Pane button
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e From the Map tab, click the Basemap button.
e Review the various available basemaps.
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 Turn on the Toronto Neighbourhood layer
e Right-click the layer name and choose Zoom to Layer
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e Right-click the Toronto Neighbourhood layer in the Contents Pane
e Click the Label menu item to enable labeling
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e Turn on the Greenspace layer
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urn on the Contour and Road layers
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e Turn on the iNaturalist Observations layer
o [Naturalist is a social network for sharing and identifying biodiversity observations. Esri
has made this data available as a web service.
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Navigation

e Using the mouse
buttons and wheel,
navigate around your
map.

e To reposition the view
on your Toronto data,
right-click the
Neighbourhoods layer
and select Zoom to
Layer.
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Scale

e \arious map scales
may be selected
from the dropdown at
the bottom left of the

map area.

Map

Contents

Drawing Order

Insert

4 b

Analysis

Explore "™ ¢

Catalog

Project |

52



Bookmarks

Project Map Insert Analysis

Bookmarks are navigation
shortcuts to positions on a
map.
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Contents : x Map Bookmarks

e Under the Map tab,
click the Bookmarks
button.

e Click on the Canada
bookmark.
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Bookmarks

e Repeat the previous
step, but instead
choose the Toronto
bookmark.
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Exploring
Data

e Right-click the
Neighbourhoods layer
and choose Attribute
Table (or press Cirl + t).

e Click on any record
within the table.

e Note that the highlighted
row corresponds to the
highlighted map

polygon.
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Exploring
Data

e Click the Clear
button in the
Selection group
under the Map
tab to clear the
selection.
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Exploring
Data
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Data
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Pop_Males Pop_Males Double 0 (0% 2,990 26,005| 8,967.642857 4 41

Pop_Females Pop_Females Double 0 (0% 3,500 27,330 9,710.142857 4,7,

e Data Engineering
allows you to get
an overview of your
data, as well as 0 of 140 selected | 140 of 140 used to caculate statstcs
look for outliers,
missing values,
and other Issues.
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Symbolizing

Data

e The Symbology
Pane will appear.

e From the Primar
Symbology
dropdown, select
Graduated
Colors.
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Symbolizing
Data

e From the Field
dropdown, select
Total_Population.

Primary symbology

Graduated Colors

Field

Normalization

Method

Classes

Color scheme

Classes

Catalog

Histo

Total_Area

Tatal Aras

Total_Population

Darn AAslac

Pop_Females

PopO_4years

Pop5_Y9years

Pop10_14years
Pop15_19years
Pop20_24years
Pop25_29years
Pop30_34years
Pop35_39years
Pop40_44years
Pop45_49years
Pop50_54years
Pop55_59years
Pop60_64years
Pop65_69years
Pop70_74years
Pop75_79years

@7



Symbolizing
Data

Graduated Colors

Field Total_Population

e Choose a colour

Normalization <None>

SCheme that begins Method Natural Breaks (Jenks)

Classes 5

with a lighter colour
and ends with a
darker or more
saturated colour.

Classes Histogram Scales

Upper value Label

< 12530 6490 - 12530

. 18805 12540 - 18810
< 25640 18820 - 25640
< 34650 25650 - 34650

< 53350 34660 - 53350




Symbolizing
Data

e The neighbourhood
polygons have been
symbolized as per the
underlying attribute
values.

o Note: | have turned off the
INaturalist layer and
neighbourhood labels for
visual clarity here.

Vaughan

Richmond Hill

Markham

Primary symbology

Total_Population

<None>

Classes Histogram Scales

Symbol Upper value

< 18805

12540 -

18810




ymbolizing
Data

e From the
Normalization p—
dropdown in the

Vaughan

Primary symbology

Normalization |Total_Area

select Total_Area e i Sl nealivanaly 0

Classes

Color scheme

Classes Histogram Scales

e The information is ot o R NG
now expressed in o Bl e
terms of population e e
density rather than
raw counts.

iga
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Exporting a
map

e From the Output
group on the Share
tab, click Export
Map (or press Ctrl
+ e).

e Choose Vector
PDF.

Project Style Map Layer
Template Items File File

Save As

¢

3

Weston-Pellam
Park

Map Mapv

Export Presets

Default AIX -
Map

@

Vector PDF -
Map

E Open preset

Print E)(pc)rt (apture To

lipboard

@

Flattened PDF -

Map

&
TIFF

GeoTIFF - Map




Exporting a
map

e From the Export
Map pane, click
Export.

e Your map view will
be saved to your

file system as a
PDF.

Map

Properties Security

v File

File Type
PDF

Name

\workshops\ProWorkshopGraphics\Maplpdf ™~

Show selection symbology

v Compression

Output as image

Image compression |Adaptive

Quality

Low

v'| Compress vector graphics

v Image Size

Units
Width

Pixels

1280

Symbology




Other helpful features

Shortcut Keys

e All of Pro’s functionality can
be accessed using the
keyboard alone.

e See https://pro.arcgis.com
/en/pro-app/latest/get-
started/arcgis-pro-keyboard-

Keyboard shortcut

Action

Ctrl+O Open a project.

Ctrl+N Create a project.

Ctrl+S Save the project.

Ctrl+M Open a new map.

Ctrl+F1 Show or hide the ribbon.

F12 Open the Keyboard Shortcuts dialog box.

Ctrl+E Open the Export pane to export a map, layout, or report.
Alt+Q Search for a command.

Alt or F10 Enable access keys and show KeyTips on the ribbon.

Right arrow key or Left arrow key

Move from one tab to another in the active pane.

shortcuts.htm for a more
complete list.

Tab or Shift+Tab

Move from one command to the next on a ribbon tab.

Up arrow key or Down arrow key

Move among elements in a list.

Alt+Down arrow key

Open a drop-down menu or list.

Esc

Close a drop-down menu or list.

Enter or Spacebar

Run a command

Shift+Windows key+F10

Open a context menu (pop-up menu) for a selected item.




Getting Help

e From the Help tab,
choose Help ->
Online Help

e A website will be
launched where you
can access detailed
documentation for
the latest version of
Pro.

=22l Quick Access Toolbar

v v “

Project Map Insert Analysis View Edit Imagery Share Help

& Ribbon ‘ | ‘

Help Learning Diagnostic Esri Technical
Shortcuts v Resaurces Manitor Community Support

Customize . Contact Us
Ustomize Online Help e

—— Nﬂ
. o

Contents

ArcGIS Pro help

Create projects

Map and visualize your data



Getting Help

= - . . i O
@esrl Products ~ Industries ~ Support & Services v Stories v About ~ Q @ <

A | Esri Academy

o Visit
https://www.esri.com
/training/ and log in
with your UTORId.

Explore Our Courses

Browse by Topic

H)
g2,

Getting Started ArcGIS Products Data Management Mapping Spatial Analysis & Field Operations Scripting & Imagery & Remote 3D Visualization &
. e o u rs e ata o g Data Science Development Sensing Analytics
t L]
Ly FORMATS Viewing All 2 PRODUCTS Viewing All 2 Maintenance Subscription Free SORT Recently Added 2 VIEW R =
elptul, beginner-
)
f = d I t t = I Viewing Results: 500
riendly tutorials.

Using ArcGIS AllSource for Geospatial . Esri ArcGIS Pro Foundation Certification ) Esri ArcGIS Pro A
Intelligence Analysis 2025

. Added by Esri Technical Certification on August 13, 2024

ssociate Certification 2025
@ Added by Esri Technical Certificat 4

tion on August 13, 2024

2 Days (16 Hours)




Getting Help

e Contact the Map and
Data Library

utoronto.ca

COLLECTIONS ~ TECHNOLOGY ~ SUPPORT ~

Search the Map and Data Library

Q Ma

Scanndg

Hours & Location Using the library

COVID-19 Data Guide

Request map retrieval

Contact us for help with data, maps or GIS

Request an Esri software license (ArcGIS Pro, etc)

Request an NVivo license

Robarts Library
130 St. George St.,

Toronto

Sign up for a workshop

Browse our tutorials & guides
Map

. : Use our computer lab
Note: we have temporarily moved to the seventh floor. We are available

in-person by appointment only. Please also note that computers with
Find maps In our collection

advanced GIS and statistics software are available in the fourth floor

olp a0 2 anm with "MDW!" an the al= aln



Next Steps

e | ayout creation

e | pading and
manipulating data

e Analysis

e \Working with raster
data

e Automation and Al




Thank you!



